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EDMS 5.0 provides a number of major new capabilities compared to EDMS 4.5. This document 
provides a summary of the major changes between EDMS 4.5 and EDMS 5.0. Further 
information about the new modeling options can be found in the EDMS 5.0 User’s Manual. 
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1 Study & Overall Modeling Changes 
 

1.1 Multiple Scenarios, Airports, Years 
Studies can now contain multiple scenarios, multiple airports and multiple years. Whatever 
airports are included in the study are included in every scenario, however airport details, such as 
runway layout, can vary from scenario to scenario within the study. Furthermore, for each 
scenario-airport combination the operational usage of the emissions sources can change from 
year to year. Refer to Section 1.3.3 Structure of an EDMS Study of the EDMS User’s Manual for 
more information. 

1.2 Dispersion Modeling Options Available for Emissions Inventory 
The concept of the “emissions only” and “emissions and dispersion” modes has changed. The 
emissions inventory is able to use the exact same data as the dispersion analysis. This includes 
the ability to model configuration changes and queuing in conjunction with meteorological data. 
Therefore, if the AERMET wizard is run, these meteorological conditions will be applied to the 
emissions inventory. 
 
EDMS now gives the choice of whether or not to have “dispersion enabled”. When dispersion is 
enabled, it requires certain other options to be selected: dynamic performance-based aircraft 
modeling (in-air and runway movement), sequence modeling (for taxi times), and hourly weather 
data. If those same options are selected when dispersion is not enabled, the results of the 
emissions inventory will be exactly the same as they are with dispersion enabled. Sections 1.3.2 
and 1.3.4 of the EDMS User’s Manual give a good overview about these options, and Sections 
2.2 and 3.1 give detailed descriptions. 
 
Supporting this has changed the functional flow through EDMS. For example, the weather 
option must be handled before an emissions inventory can be run. The new procedures for 
emissions inventories and dispersion analyses are explained in Sections 1.3.6 and 1.3.7 of the 
EDMS User’s Manual. 

1.3 Operational Profiles 
Operational profiles must be defined in 15-minute (quarter-hour) bins, as opposed to the hourly 
bins used in EDMS 3.X and 4.X. This is to support more precise aircraft delay and sequence 
modeling. As a consequence of this change the peak hour fields have been changed to peak 
quarter hour. 
 
Studies converted from EDMS 4.5 have their peak hour values divided by 4 to give the peak 
quarter hour in EDMS 5.0. Similarly, users who have peak hour data for their 5.0 study 
should divide by 4 before entering as a peak quarter hour. 

1.4 Menu Items 
In conjunction with the new EDMS 5.0 architecture, there has been some reorganization of the 
menus. 
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Changes to the Study Setup dialog in EDMS 4.5: 
 

1. Mixing Height and the AERMET wizard have moved to a new Weather dialog, which is 
found under the Airport menu header. The weather dialog also displays and allows to be 
edited various annual average weather parameters. 

2. The contents of the Domain tab of the Study Setup dialog have moved to the Run 
AERMAP dialog. The fields for naming the .REC and .SRC files have been removed to 
accommodate the use of multiple scenarios and airports. 

3. Options for the Aircraft Times in Mode have been moved from Study Setup to the 
Scenario Properties dialog. 

4. The option to specify the desired MOBILE model as well as the option to select the GSE 
modeling basis have been removed. EDMS 5.0 uses only MOBILE 6.2 and permits both 
GSE assignment and GSE population within the same scenario. 

5. The Study Type has been replaced with the Enable Dispersion checkbox on the new 
Study Properties dialog. 

6. Airport information from the Study Setup dialog’s General tab has moved to the Airport 
Properties dialog. 

7. The Units of Measure tab of the Study Setup dialog is now part of the Study Properties 
dialog. 

 
Changes to other dialogs: 
 

8. The Operational Profiles menu item has moved from under the File menu to the Utilities 
menu. 

9. The Configurations dialog has moved from under the Dispersion menu header to the 
Airport menu header, since these can now be used without dispersion as well. 

10. The Taxiway Assignment tab of the Configurations dialog is gone, as taxiway usage is 
now computed automatically. 

11. Import and Export have moved from under the Utilities menu header to the File menu 
header. 

12. Runway queues are now computed dynamically by the sequencing model, and so are not 
needed on the Runways dialog. 

13. The Aircraft Operations & Assignments tabs have been completely reorganized with 
many additions and deletions due to the major modeling changes involving aircraft. 

1.5 Saving Study 
The study data are not saved automatically. In previous versions of EDMS, pressing “OK” in any 
dialog stored the data directly into the study tables on disk. In EDMS 5.0, open study is loaded 
into the computer memory, and the user must explicitly “save” the data to disk, by pressing 
control-S, selecting Save from the File menu, or pressing the save icon on the toolbar.  This will 
allow you to revert to the last saved version of your file, if you should make an error while 
entering data. However, updating the emissions inventory will automatically save the study data 
upon completion of the emissions calculations. 
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2 Emissions Modeling 
 
Updating emissions will calculate emissions for all scenarios, airports, and analysis years. In 
addition, if Dispersion is enabled, the HRE hourly emissions files will be generated for all 
pollutants at the same time as emissions is updated, which could take some time. Selecting “Run 
AERMOD” from the Dispersion menu will run AERMOD for all analysis years for the selected 
scenario and airport. 

2.1 Emissions Module 
The emissions module is used to compute aircraft emissions dynamically based on performance 
parameters and weather conditions. When hourly weather data is being used, emissions are 
computed for each aircraft operation individually. 

2.2 Particulate Matter 
The First Order Approximation 2.0 (FOA2) used in EDMS 4.5 estimated the volatile fraction of 
particulate matter using just a scalar applied to the non-volatile fraction. EDMS 5.0 uses FOA3, 
which predicts the volatile PM from secondary PM drivers, namely Sulfur conversion chemistry 
and condensed organic gases. 
 

3 Dispersion Modeling 
 
The process for conducting a dispersion analysis has changed, mainly to support the ability for 
an emissions inventory to use the same modeling options and produce the same results as the 
emissions that is actually dispersed. For a more detail explanation of the changes, see Sections 
1.3.6 and 1.3.7 of the EDMS User’s Manual. 
 
Dispersion is now performed on all mass emissions up to the mixing height (no longer just to 
1,000 feet above ground level). To avoid a significant runtime penalty, emissions from 1,000 feet 
to the mixing height are collapsed to a series of area sources at the midpoint between the two 
altitudes. 
 

4 Airports 
 
The aircraft-related settings for the airport layout can now be used for emissions inventory also, 
not just dispersion. 

4.1 Airports Database 
The Airports Database has been completely redesigned with the addition of about 10,000 more 
airports (nearly 35,000 total airports worldwide). The airports database is now common to the 
Integrated Noise Model, and also includes average annual weather data for many US airports. 
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4.2 Weather 
There is a new weather dialog that allows the user to choose between annual average or hourly 
weather when dispersion is not enabled. The user can also set the mixing height here and when 
selected, modify the annual average values. The AERMET wizard is launched from this dialog. 
 
EDMS now uses a third AERMET file in addition to the surface (.SFC) and profile (PFL) files 
that were used in 4.5. The third file, the AERMET surface observation file (SFQAFILE.MET), is 
an intermediate file output by AERMET, which retains all of the meteorological parameters that 
were originally contained in the user-supplied surface data file. EDMS directly reads that file to 
get the hourly weather, which directly affects aircraft performance (when dynamic performance-
based modeling is used), aircraft emissions, and the selection of the active airport configuration. 
The airport configuration, in turn, affects sequence modeling (taxi times) and runway usage. 
 
In EDMS 4.5, the average daily high and low temperatures were set to the average daily 
temperature ±10.35 °F. In EDMS 5.0, they default to those same values, but can be edited by the 
user. Altering these values will affect the vehicle emissions results from MOBILE. 
 
Weather is discussed in detail in Section 3.1 of the EDMS User’s Manual. 

4.3 Taxiways & Taxipaths 
The definition of taxiways is significantly simpler in EDMS 5.0 than in EDMS 4.5, since they 
can consist of multiple segments. The user may now choose from 2 to 20 points (1 to 19 
segments) for each taxiway. Another difference for Taxiways is the addition of elevation. See 
Section 4.1.2 of the User’s Manual for more information on elevation, and to Section 6.4.4 for 
taxiways. 

Taxipaths are a new concept for EDMS 5.0.  This is the set of taxiways that are used to link 
aircraft with gates and runway ends.  To define a taxipath, the set of taxiways for the airport must 
first be defined.  See Section 6.4.6 of the User’s Manual for more information on Taxipaths. 

4.4 Runways 
Runways in EDMS 5.0 no longer have a queue. Queuing delay is computed by the sequencing 
model, and the delayed aircraft back up along the taxiways defined in their taxipath. Runways 
are not necessarily perfectly level; an elevation can be entered for each runway end. Also a glide 
slope can be assigned to each runway end that will be used when the Use Runway Glide Slope 
checkbox is checked on the Performance tab of the Aircraft Operations & Assignments dialog. 
See section 6.4.5 of the User’s Manual for more details about runways. 

4.5 Runway Configurations 
The Configurations dialog has been significantly improved, most notably with the addition of 
airport capacity information, which is used to determine aircraft delays. Also, in addition to wind 
direction and speed used in EDMS 4.5, EDMS 5.0 also uses hour of the day, ceiling, visibility 
and temperature as activation parameters to determine which configuration is active. Taxiway 
assignments are no longer needed, as taxiway usage is determined by the sequencing model. 
Also, aircraft are no longer directly assigned to runways, since the runway configurations will 
determine the runway assigned to each aircraft operation. 
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The user can also require specific configurations to be used for a fixed percentage of the time, 
and EDMS will match the required percentages, while trying to satisfy the wind direction 
activation requirements as well as possible. See Section 6.4.7 of the EDMS User’s Manual for 
details of how to use the configurations. 
 

5 Aircraft 

5.1 Aircraft Fleet 
 
The EDMS system table CONV45_5.DBF found in SYS_DATA\Fleet\Common in the 
installation directory contains all aircraft mappings from EDMS 4.5 to EDMS 5.0. All aircraft 
from EDMS 4.5 appear in EDMS 5.0 except for the Alpha 70 and the MIG-18-50 which are no 
longer supported. In addition to the EDMS 4.5 aircraft, EDMS 5.0 now contains several new 
aircrafts, found in Appendix A. In EDMS 4.5 each aircraft was identified using an AIR_NAME, 
and each engine using an ENG_UID. In EDMS 5.0, each aircraft is identified by an ACCODE, 
which is a unique alphanumeric identifier based on BACK aircraft types. Similarly, each engine 
is identified by a UID, which a unique alphanumeric engine identifier based on ICAO UID. 
 
The fleet database is now common to the Integrated Noise Model, which aides in the future 
integration of the two tools. 

5.2 Dynamic Flight Performance Modeling 

EDMS 5.0 has a dynamic flight performance module that provides flight path, timing and fuel 
burn dependent on specifics such as weather, and individual aircraft and engine characteristics. 
The dynamic flight profile generator is based on SAE 1845 and BADA performance, and can 
compute profiles for all EDMS aircraft, including helicopters. 

5.2.1 Flight Profile Performance Data 
In EDMS 4.5, the takeoff portion of a departure was assumed to end at 1,000 feet. With the 
dynamic flight performance module, the transition from takeoff to climb out is now variable, 
depending on aircraft performance characteristics and weather. 

5.2.2 Usage of Weather Data 
In EDMS 4.5, the emissions calculations using both the ICAO Times In Mode and Performance-
Based modeling assumed the standard day weather conditions and was read from a table. In 
EDMS 5.0 actual available weather (either annual average values or hourly values) is used for 
both ICAO Times In Mode and performance-based modeling. 
 
If hourly weather data is being used with performance-based aircraft modeling, EDMS 5.0 will 
compute a distinct profile for every aircraft operation. If the airport’s annual average weather is 
being used, all profiles for each aircraft-engine combination would be the same throughout the 
year, so EDMS computes the profile just once for each aircraft type. 
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5.3 Aircraft Schedule 
In lieu of using operational profiles, historic aircraft scheduling information can be used to feed 
the sequencing model. Details about using a schedule file can be found in the EDMS User’s 
Manual, Section 6.3.1.2. 

5.4 Delay & Sequence Modeling 
More detailed modeling of aircraft movement on the ground gives more accurate estimates of 
taxi times and location of emissions for dispersion. The model uses a modification of the 
WWLMINET’ Airport model to determine overall delays for each our based on the provided 
airport capacity. In addition, the Delay & Sequencing Model uses airport layout information such 
as gates, runways, taxiways, taxipaths, and configurations as well as scheduling information to 
compute the ground movement of aircraft. 

5.5 Emissions Calculations 
An emissions module provides more precise emissions for aircraft based on the results of the 
performance module. The emissions module uses Boeing Fuel Flow Method 2 to scale emissions 
for a continuous range of weather conditions, rather than just standard atmospheric conditions. 

5.6 Aircraft Main Engine Startup 
Aircraft main engine startup emission is now also modeled, and is reported in its own “Startup” 
aircraft mode of operation, and is attributed to the AERMOD gate source to which the aircraft is 
assigned. 

5.7 Modes of Operation 
In EDMS 4.5, there were 4 aircraft modes of operation: Approach, Idle, Takeoff, and Climb Out. 
EDMS 5.0 allows the user to not only specify LTO cycles, but also separate arrivals and 
departures, with independent numbers of operations. So, the Idle mode has been separated into 
Taxi In and Taxi Out modes. In addition, a Startup mode has been added for aircraft main engine 
startup. For more information on the new 6 aircraft modes of operation in EDMS 5.0, please see 
Section 2.2 Aircraft Activity of the EDMS User’s Manual. 
 

6 Non-Aircraft Sources 
 

6.1 GSE Modeling Differences 
Assigning GSE to aircraft and using GSE population are no longer mutually exclusive; both can 
be used in the same study. 
 
The GSE_EF and NORNROAD tables, which contain emission factors for the GSEs have been 
updated based on values from EPA’s NONROAD 2005. GSE_EF contains the emission factors 
used when Use default age distribution is selected, and NONROAD contains the emission factors 
used when Specify a specific age is selected in the GSE Population dialog. 
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6.2 Parking Facilities Modeling Differences 
EDMS 5.0 uses only MOBILE 6.2 for emissions factors computation, while EDMS 4.5 allowed 
the option to use either MOBILE 5a, 5b, and 6.2. The MOBILE model is affected by the 
weather, so check Section 1.1 of the release notes for more information on weather related 
changes. 
 
The only other difference between EDMS 4.5 and 5.0 for Parking Facilities is the addition of 
elevation. See Section 4.1.2 of the User’s Manual for more information on elevation. 

6.3 Roadways Modeling Differences 
A single roadway can now be composed of multiple segments. In addition, the fleet mix for that 
roadway can be defined, without having to duplicate the roadway as with EDMS 4.X. Also, 
Emissions for Roadways in EDMS 4.5 were automatically doubled to model round-trip. In 
EDMS 5.0, Roadways emissions are not doubled. 

The number of vehicles in 4.5 has been replaced with traffic volume, which is the total 
number of vehicle traversals on the road.  

The round-trip distance in 4.5 has been replaced with roadway length and emissions for 
roadways are generated as though they are one-way operations.  

Note: In order to model a EDMS 4.5 roadway in EDMS 5.0, the user must use half of the round-
trip distance as roadway length, and double the yearly number of vehicles for yearly traffic 
volume. 
 
EDMS 5.0 uses only MOBILE 6.2 for emissions factors computation, while EDMS 4.5 allowed 
the option to use either MOBILE 5a, 5b, and 6.2. The MOBILE model is affected by the 
weather, so check Section 1.1 of the release notes for more information on weather related 
changes. 

6.4 Stationary Sources 
New aircraft engines were added for aircraft engine testing. There are no modeling differences 
between EDMS 4.5 and 5.0 Stationary Sources.  

6.5 Training Fires 
There are no modeling differences between EDMS 4.5 and 5.0 for Training Fires, except for the 
addition of elevation. See Section 4.1.2 of the User’s Manual for more information on elevation. 

6.6 Gates 
In addition to all modeling inputs of EDMS 4.5, EDMS 5.0 adds elevation and the dispersion 
parameters Initial Sigma-Z and Initial Sigma-Y. See Section 4.1.2 of the User’s Manual for more 
information on elevation and to Section 6.4.3 for more information on the dispersion parameters 
Initial Sigma-Z and Initial Sigma-Y.  
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7 Other Changes 

7.1 AERC Report 
The Airport Emissions Reduction Credit (AERC) report is now part of EDMS, rather than being 
an external application. The AERC report can be generated within EDMS 5.0 by selecting AERC 
Report from the View menu. See Section 6.6.2 of the User’s Manual for more information on 
how to select the baseline scenario and generate an AERC report. 

7.2 Study Import/Export 
The text file generated from the Study Export, which is also used for Study Import, is now 
delimited by a semicolon rather than comma. 
 

8 EDMS 4.5 to EDMS 5.0 Study Conversion 
 
EDMS 5.0 will support studies last saved in the EDMS 4.5 study format. To open studies saved 
in older versions of EDMS, the user will need to open and save the study using EDMS 4.5 first; 
then open the study using EDMS 5.0. The study conversion will not alter original data, but will 
instead retrieve information from the original study and save it in a new location. The user will 
then be prompted to provide the new location and name for the study.   
 
EDMS 4.5 studies for computing Emissions only, will be fully converted, and the user will be 
able to update emissions once the conversion is finished. Studies that have dispersion enabled, 
however, will require the user to provide additional information before being able to update 
emissions. 

The following list shows the EDMS 4.5 data that will not be converted due to the modeling 
differences in EDMS 5.0: 

• The Study Setup dialog: 
o GSE modeling base selection 
o Mobile model selection 

• The Aircraft dialog: 
o Runway assignments 
o Taxiway assignments 

• The Runway and Queues dialog: 
o The queue information will not be used (this includes its location, the Peak Queue 

Time and the Queue Hourly Profiles) 
• The Runway/Taxiway Configurations dialog: 

o Data provided in the Taxiway Assignment tab 
• The Receptors dialog: 

o Polar receptors for which the Origin Source is a Queue 

Typically, the conversion maps the EDMS 4.5 data into EDMS 5.0 without making any changes. 
For the following items, however, the EDMS study conversion will automatically perform the 
following operations: 
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• The Roadways dialog: 
o The Round-Trip Distance is divided by 2 to get the Roadway Length  
o The Number of vehicles is doubled since each operation represents a vehicle 

traversing the roadway once (not a round trip as it was in EDMS 4.5).  
• The Operational profiles dialog: 

o Hourly profiles are converted into quarter-hourly profiles. Furthermore, “Per Peak 
Hour” data are converted into “Peak Qtr Hour” in all dialogs. 

• Assign default values for all modeling inputs that are new in EDMS 5.0 and which were 
not available in EDMS 4.5 (e.g. elevation in the Runways, Taxiways, Roadways dialogs, 
and capacity in the Configuration dialog). 

Once the conversion is finished, studies with dispersion enabled require the user to provide the 
following additional information before being able to update emissions: 

• Define Taxipaths 
• Provide proper settings for Runway Configurations 

Note:  None of the results from previous emissions and dispersion runs will be converted and 
the user will not be able to view the results of completed runs, including the Emissions 
Inventory, AERC report or Concentrations without first updating emissions. 



11 

Appendix A. New Aircraft 
 
The following list shows the 220 aircraft that are new in EDMS 5.0. Refer to the system tables 
located in SYS_DATA\Fleet\Common for more information on these aircrafts. 
 
Aviat Husky A1B 
Airbus A300B2-300 Series 
Airbus A300F4-600ST Beluga 
Airbus A319-100 X/LR 
Airbus A321-200 Series 
Airbus A340-500 Series 
Airbus A380-100 Series 
Airbus A380-200 Series 
Airbus A380-800 
Boeing Stearman PT-17 / A75N1 
Aerostar PA-60 
Antonov 12 Cub 
Antonov 124 Ruslan 
Antonov 140 
Antonov 24 Coke 
Antonov 26 Curl 
Antonov 30 Clank 
Antonov 32 Cline 
Air Tractor AT-502A 
Air Tractor AT-502B 
Air Tractor 802 
ATR 42-300 
ATR 42-320 
Avro RJ-100 
Avro RJ-70 
Avro RJ-85 
Boeing Business Jet (BBJ) 
Boeing Business Jet II 
Boeing 747-400 ER 
Boeing 767-400 
Boeing 777-300 ER 
BAC 1-11 475 
BAC 1-11 500 
BAE 146-100QT Quiet Trader 
BAE 146-200QT Quiet Trader 
BAE 146-300QT Quiet Trader 
Raytheon Beech 18 
Raytheon Beech 1900-D 
Raytheon Beech Bonanza 36 
Raytheon Beech 55 Baron 
Raytheon Beech Baron 58 
Raytheon Beech 60 Duke 
Britten-Norman BN-2 Islander 
Britten-Norman BN-2A Mk III 
Trislander 

CASA 212-100 Series 
CASA 212-200 Series 
CASA 212-300 Series 
CASA 212-400 Series 
CASA 295 
Bombardier CL-415 
Bombardier Challenger 300 
Bombardier Challenger 602 
CASA CN-235-100 
CASA CN-235-300 
Cessna 182 
Cessna 206 
Cessna 210 Centurion 
Cessna 310 
Cessna 340 
Cessna 402 
Cessna 404 Titan II 
Cessna 414 
Cessna 421 Golden Eagle 
Cessna 425 Conquest I 
Cessna 525 CitationJet 
Cessna 560 Citation Excel 
Cessna 560 Citation XLS 
Rockwell Commander 500 
Rockwell Commander 680 
Rockwell Commander 690 
Convair CV-440 
Convair CV-580 
Raytheon Beech D17S Staggerwing 
Boeing DC-3 
Boeing DC-6 
DeHavilland DHC-2 Mk III Beaver 
DeHavilland DHC-3 Otter 
DeHavilland DHC-6-200 Twin Otter 
DeHavilland DHC-8-100 
DeHavilland DHC-8-200 
DeHavilland DHC-8-300 
Dornier 128 Skyservant 
Dornier 228-100 Series 
Dornier 228-200 Series 
Embraer 312 Tucano 
Embraer ERJ135 
Embraer ERJ135-ER 
Embraer ERJ135-LR 

Embraer ERJ145-ER 
Embraer ERJ175 
Embraer ERJ175-LR 
Embraer ERJ190 
Embraer ERJ190-LR 
Embraer ERJ195 
Embraer ERJ195-LR 
Fokker F27-100 Series 
Fokker F27-200 Series 
Fokker F27-300 Series 
Fokker F27-400 Series 
Fokker F27-500 Series 
Fokker F27-600 Series 
Fokker F27-700 Series 
Dassault Falcon 10 
Dassault Falcon 200 
Dassault Falcon 2000 
Dassault Falcon 20-D 
Dassault Falcon 20-E 
Dassault Falcon 20-F 
Dassault Falcon 20-G 
Dassault Falcon 50-EX 
Dassault Falcon 900 
Dassault Falcon 900-B 
Dassault Falcon 900-C 
Dassault Falcon 900-EX 
Grumman G-21G Goose 
Grumman G-73 Mallard 
Gulfstream G100 
Gulfstream G150 
Gulfstream II-B 
Gulfstream II-SP 
Gulfstream G350 
Gulfstream IV-SP 
Hawker HS-125 Series 1 
Hawker HS-125 Series 3 
Hawker HS-125 Series 400 
Hawker HS-125 Series 600 
Raytheon Hawker 800 
Hawker HS748-1 
Hawker HS748-2 
Israel IAI-1121 Commodore 
Israel IAI-1123 
Israel IAI-1125 Astra 
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Israel IAI-1126 Galaxy 
Ilyushin 18 Clam 
BAE Jetstream 32-EP 
Lockheed L-1329 Jetstar II 
BAE Jetstream 1 
BAE Jetstream 200 Series 
Let 410 
Let 410-UVP 
Let 420 Tubolet 
Lancair 360 
Bombardier Learjet 23 
Bombardier Learjet 24-XR 
Bombardier Learjet 25-XR 
Bombardier Learjet 28 
Bombardier Learjet 29 
Bombardier Learjet 36 
Bombardier Learjet 40 
Bombardier Learjet 45 
Bombardier Learjet 45-XR 
Bombardier Learjet 55 
Bombardier Learjet 60 
Maule MT-7-235 
Boeing MD-10-30 
Boeing MD-11-ER 
C-26A 
Boeing F-15E Strike Eagle 
Hawker Hunter 
Rockwell 1121 Jet Commander 
Rockwell 1121A Jet Commander-A 
Rockwell 1121B Jet Commander-B 

Lockheed P-3 Orion 
Grumman S-2E Tracker 
T-38 Talon 
Fairchild Metro IVC 
Mooney M20-K 
Mitsubishi MU-2 
Ryan Navion B 
Ryan Navion F 
Nord Transall C-160 
Piaggio P-166 
Piaggio P.180 Avanti 
Partenavia P.68 Victor 
Piper PA-27 Aztec 
Piper PA-34 Seneca 
Piper PA46-TP Meridian 
Pilatus PC-12 
Pilatus Turbo Trainer PC-9 
Raytheon Premier I 
Rans S7S 
Reims-Cessna 406 Caravan II 
Fairchild SA-26-T Merlin II 
Saab 2000 
Saab 340-B 
Rockwell Sabreliner 40 
Rockwell Sabreliner 50 
Rockwell Sabreliner 60 
Rockwell Sabreliner 65 
Shorts Skyvan SC7-3-1 
Shorts Skyvan SC7-3-2 
Shorts Skyvan SC7-3A-1 

Shorts 330-100 Series 
Shorts 330-200 Series 
Shorts 360-200 Series 
Shorts 360-300 Series 
Shorts SC.5 Belfast 
Cirrus SR20 
Cirrus SR22 
Ryan ST3KR 
Raytheon Starship 2000 
Aero Spacelines Super Guppy 
Ayres Turbo Thrush T-65 
EADS Socata TBM-700 
EADS Socata TB-20 Trinidad 
Tupolev Tu-330 
Martin WB-57F Canberra 
Harbin Y-12 
Yakovlev 40 Codling 
NAMC YS-11A-200 Series 
NAMC YS-11A-300 Series 
NAMC YS-11A-400 Series 
NAMC YS-11A-500 Series 
NAMC YS-11A-600 Series 
NAMC YS-11A-700 Series 
Xian Yunshuji Y-7 
Agusta A-109 
Boelkow BO-105 
Hughes 500D 
Sikorsky S-76 Spirit 
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Appendix B. New Engines 
 
The following list shows the 69 engines that are new in EDMS 5.0. Refer to the system tables 
located in SYS_DATA\Fleet\Emissions for more information on these engines. 
 
 
501 D13 alternative 1 
501 D13 alternative 2 
AI-24VT 
CF34-10E 
CT7-5A2 
CT7-9B 
DART 514 
DART 552 
GP727X 
GP7XXX 
PT6A-11 
PT6A-110 
PT6A-112 
PT6A-114A 
PT6A-121 
PT6A-135A 
PT6A-15AG 
PT6A-21 
PT6A-25C 
PT6A-38 
PT6A-40 
PT6A-45AG 
PT6A-45B 

PT6A-61 
PT6A-62 
PT6A-64 
PT6A-65AG 
PT6A-66 
PT6A-67 
PT6A-67A 
PT6A-67AF 
PT6A-67AG 
PT6A-67CF 
PT6A-67R 
PT6A-68 
PW121A 
PW127 
PW127B 
PW127D 
PW127G 
PW150A 
T56-A-14 
TPE331-1 
TPE331-10A 
TPE331-10G 
TPE331-10GT 

TPE331-10N 
TPE331-10R 
TPE331-10U 
TPE331-10UA 
TPE331-10UG 
TPE331-10UK 
TPE331-11U-601G 
TPE331-12B 
TPE331-12UA 
TPE331-12UHR 
TPE331-14B 
TPE331-14GR 
TPE331-15AW 
TPE331-1UA 
TPE331-2UA 
TPE331-3U 
TPE331-3W 
TPE331-5A 
TPE331-5B 
TPE331-6 
Trent 970-84 
TRENT97X 
TRENT9XX 

 


